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This presentation is for information only and does not constitute or form part of an offer, solicitation, recommendation or invitation for the sale or purchase or subscription of securities, including units in

Frasers Logistics & Commercial Trust (formerly known as Frasers Logistics & Industrial Trust) (“FLCT”, and the units in FLCT, the “Units”) or any other securities of FLCT. No part of it nor the fact of its

presentation shall form the basis of or be relied upon in connection with any investment decision, contract or commitment whatsoever. The past performance of FLCT and Frasers Logistics & Commercial

Asset Management Pte. Ltd. (formerly known as Frasers Logistics & Industrial Asset Management Pte. Ltd.), as the manager of FLCT (the “Manager”), is not necessarily indicative of the future

performance of FLCT and the Manager.

This presentation contains “forward-looking statements”, including forward–looking financial information, that involve assumptions, known and unknown risks, uncertainties and other factors which may

cause the actual results, performance, outcomes or achievements of FLCT or the Manager, or industry results, to be materially different from those expressed in such forward-looking statements and

financial information. Such forward-looking statements and financial information are based on certain assumptions and expectations of future events regarding FLCT's present and future business

strategies and the environment in which FLCT will operate. The Manager does not guarantee that these assumptions and expectations are accurate or will be realised. You are cautioned not to place

undue reliance on these forward-looking statements, which are based on the Manager’s current view of future events. The Manager does not assume any responsibility to amend, modify or revise any

forward-looking statements, on the basis of any subsequent developments, information or events, or otherwise, subject to compliance with all applicable laws and regulations and/or the rules of the

Singapore Exchange Securities Trading Limited (“SGX-ST”) and/or any other regulatory or supervisory body or agency.

The information and opinions in this presentation are subject to change without notice, its accuracy is not guaranteed and it may not contain all material information concerning FLCT. None of Frasers

Property Limited, FLCT, the Manager, Perpetual (Asia) Limited, in its capacity as trustee of FLCT, or any of their respective holding companies, subsidiaries, affiliates, associated undertakings or

controlling persons, or any of their respective directors, officers, partners, employees, agents, representatives, advisers or legal advisers makes any representation or warranty, express or implied, as to

the accuracy, completeness or correctness of the information contained in this presentation or otherwise made available or as to the reasonableness of any assumption contained herein or therein, and

any liability whatsoever (in negligence or otherwise) for any loss howsoever arising, whether directly or indirectly, from any use, reliance or distribution of this presentation or its contents or otherwise

arising in connection with this presentation is expressly disclaimed. Further, nothing in this presentation should be construed as constituting legal, business, tax or financial advice.

The value of Units and the income derived from them, if any, may fall or rise. Units are not obligations of, deposits in, or guaranteed by, the Manager or any of its affiliates. An investment in the Units is

subject to investment risks, including the possible loss of the principal amount invested. Investors should note that they have no right to request the Manager to redeem their Units while the Units are

listed. It is intended that holders of Units may only deal in their Units through trading on the SGX-ST. Listing of the Units on the SGX-ST does not guarantee a liquid market for the Units.

This advertisement has not been reviewed by the Monetary Authority of Singapore.

Nothing in this presentation constitutes or forms a part of any offer to sell or solicitation of any offer to purchase or subscribe for securities for sale in Singapore, the United States or any other jurisdiction

in which such offer, solicitation or sale would be unlawful prior to registration or qualification under the securities laws of any such jurisdiction.
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Frasers Property entities

FLCT: Frasers Logistics & Commercial Trust

FLT: Frasers Logistics & Industrial Trust

FCOT: Frasers Commercial Trust

FPL or the Sponsor: Frasers Property Limited

The Group: Frasers Property Limited, together with its subsidiaries

Financial Year

FY19: Period from 1 October 2018 to 30 September 2019

FY20: Period from 1 October 2019 to 30 September 2020

FY21: Period from 1 October 2020 to 30 September 2021

2HFY19: Period from 1 April 2019 to 30 September 2019 

1HFY20: Period from 1 October 2019 to 31 March 2020

2HFY20: Period from 1 April 2020 to 30 September 2020

1HFY21: Period from 1 October 2020 to 31 March 2021

2QFY21: Period from 1 January 2021 to 31 March 2021

3

Other acronyms

AEI: Asset Enhancement Initiative

CBD: Central Business District

COVID-19: Coronavirus disease 2019

DPU: Distribution per Unit

EURIBOR: Euro Interbank Offered Rate

FY: Financial year

GRESB: Global Real Estate Sustainability Benchmark

GRI: Gross Rental Income

IPO: Initial Public Offering

L&I: Logistics & Industrial

NAV: Net Asset Value

NLA: Net Lettable Area

p.p.: percentage points

REIT: Real estate investment trust

RBA: Reserve Bank of Australia

ROFR: Right of First Refusal

S&P: S&P Global Ratings

SGX-ST: Singapore Exchange Securities Trading Limited

SME: Small and Medium-sized Enterprise

sq ft: Square feet

sqm: Square metres

UK: the United Kingdom

WALE: Weighted average lease expiry

WALB: Weighted average lease to break

Y-o-Y: Year-on-year

Additional notes

In the tables, the arrow direction indicates the increase (up) or decrease (down) of the absolute 

figure,  The colour indicates if the change is positive (green), negative (red) or neutral (black).
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Operational stability and financial growth

1. As at 31 March 2021.   2. Based on GRI, being the contracted rental income and estimated recoverable outgoings for the month of March 2021. Excludes straight lining rental adjustments and include committed leases.   3. Prior to reaching the 50.0% aggregate 

regulatory leverage limit.

1. Operational Highlights

Proactive lease management

126,133 sqm

leased/renewed in 1HFY21

representing 5.0% of portfolio lettable area

Active Portfolio Management

Completed divestment of three non-core 

South Australian properties on 24 March 

2021

2. Robust Financials

3. Corporate Milestones

S$130.4 million

1HFY21 Distributable Income

▲ 71.1% y-o-y

3.80 Singapore cents

1HFY21 DPU

▲ 9.5% y-o-y

S$1.14
NAV per Unit(1)

▲ 3.6% from 30 Sep 20

35.3%

Aggregate Leverage(1)

S$1,929 million headroom(3)

FLCT included as a constituent 

stock of the benchmark Straits 

Times Index on 13 April 2021

High portfolio occupancy rate(1)(2)

96.8%

High-quality and resilient portfolio

Assigned first time ‘BBB+’ 

credit rating by S&P Global,

with a ‘Stable’ outlook

on 15 April 2021

BBB+
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Saalhoffer Straße 211, Rheinberg, Germany

Distribution Period 1 October 2020 to 31 March 2021

Distribution Rate 3.80 Singapore cents 

Ex-date 12 May 2021

Record Date 17 May 2021

Distribution Payment Date 18 June 2021

Distribution Timetable

DPU History (Singapore cents)

3.46 3.47

3.65

3.80

2HFY19 1HFY20 2HFY20 1HFY21

+4.1%

+5.2%

+0.3%

Stable and growing DPU



150-168 Atlantic Drive, Keysborough, Melbourne, Australia

Financial Review

Section Divider To add a background, press Insert > Pictures > Picture from File > Send to back
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1. Please refer to Pages 2 and 4 of FLCT’s Financial Statements Announcement dated 6 May 2021 for details of the capitalised terms. 2. Adjusted Net Property Income is calculated based on the actual net property 

income excluding straight lining adjustments for rental income and adding lease payments of right-of-use assets. 

3.80 Singapore cents

1HFY21 DPU

▲ 9.5% y-o-y

100%

Distributable income 

payout since IPO

Policy to hedge 

distributions on a 

rolling six-month basis 

to manage forex 

volatility on income

Key Highlights

• DPU for 1HFY21 at 3.80 Singapore cents is 9.5% higher than 1HFY20 

• Higher revenue and adjusted net property income resulted from the Merger(1) with Frasers Commercial 

Trust in April 2020, the acquisitions undertaken in FY20 and strengthening of AUD:SGD and EUR:SGD. 

This was partially offset by the effect of the Sandstone Place Divestment and SA Portfolio Divestment(1) 

and S$1.2 million of rental waivers and allowance for doubtful receivables attributable to the Covid-19 

pandemic

• The increase in finance costs was due mainly to higher borrowings due to the Merger with FCOT

• Gain on divestment of investment properties relates to (a) Sandstone Place Divestment which was 

completed on 23 November 2020; and (b) SA Portfolio Divestment which was completed on 24 March 

2021.

Financial Highlights (S$’000) 1HFY21 1HFY20 Change (%)

Revenue 231,701 118,745 ▲ 95.1

Adjusted Net Property Income(2) 173,890 96,980 ▲ 79.3

Finance costs 23,416 13,656 ▲ 71.5

Gain on divestment of investment properties 2,451 1,422 ▲ 72.4

Distributable Income to Unitholders 130,426 76,217 ▲ 71.1

DPU (Singapore cents) 3.80 3.47 ▲ 9.5
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1. Includes investment property held for sale. 2. Gross borrowings net of upfront debt related expenses, includes lease liabilities recognised due to the adoption of FRS 116 Leases effective from 1 October 2019. 

Balance Sheet (S$’000) As at 31 Mar 21 As at 30 Sep 20

Investment properties 6,461,951 6,500,881(1)

Other non-current assets 60,985 34,182

Current assets 204,799 199,584

Total assets 6,727,735 6,734,647

Loans and borrowings(2) 2,471,071 2,620,806

Other liabilities 317,739 307,164

Total liabilities 2,788,810 2,927,970

◆ The value of investment properties decreased by 0.6% from S$6,501 million as at 30 September 2020 to S$6,462 million as at 31 March 2021, due 

mainly to:

The completion of the divestment of the 50% interest in 99 Sandstone Place, Parkinson, Queensland 

The completion of the divestment of three leasehold industrial properties in South Australia

partially offset by: 

Higher AUD/SGD and GBP/SGD exchange rates 

FLCT is in a net current liability position as at 31 March 2021 due to the maturity of short-term borrowings of S$320 million. The REIT Manager is in discussion 

with banks to refinance the various loans  

◆ Net asset value per Unit increased 3.6% from S$1.10 as at 30 September 2020 to S$1.14 as at 31 March 2021.

Net asset value per Unit (S$)

1.10

1.14

30-Sep-20 31-Mar-21

As at 31 March 2021

+3.6%
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1. Based on trailing 12 months borrowing cost (including FCOT from date of completion of merger). 2. As defined in the Code on Collective Investment Schemes revised by the Monetary Authority of Singapore on 16 April 2020 

and clarified on 29 May 2020 and computed as trailing 12 months EBITDA (excluding effects of any fair value changes of derivatives and investment properties, and foreign exchange translation), over trailing 12 months borrowing 

costs. Borrowing costs include effects of FRS 116. 3. Prior to reaching the 50.0% aggregate regulatory leverage limit.

Key credit metrics

As at 

31 Mar 2021

Change from 

31 Dec 2020

Aggregate Leverage 35.3% ▼ 0.9 p.p.

Cost of Borrowings 1.9%(1) -

Average Weighted Debt Maturity 3.1 years -

% of Borrowings at Fixed Rates 70.6% ▲13.2 p.p.

Interest Coverage Ratio 6.8x(2) ▲0.3x

Debt Headroom(3) S$1,929 m ▲S$118 m

Credit Rating (S&P) BBB+ / Stable N.A.

Well-spread Debt Maturity Profile

Total Gross Borrowings: S$2,319 million

(5)

 Successfully refinanced and partially paid down c.S$378 million of borrowings in 

1HFY21

 The Manager is in advanced discussion with banks on the refinancing of the 

borrowings maturing in the next 6 months and is confident of refinancing them

19 

203 
112

20 
61 

586
66 

185
62 

138 51 

116 

140 
82 

50 

313 

115 

FY2021 FY2022 FY2023 FY2024 FY2025 > FY2025

DEBT MATURITY PROFILE 
(S$ MILLIONS, AS AT 31 MARCH 2021)

S$ Debt A$ Debt € Debt £ Debt

698

314

240

131

636

300

Key Credit Metrics
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Fixed, 
70.6%

EUR, 
11.9%

SGD, 
16.0%

AUD, 1.5%

Variable, 
29.4%

6,301

2,984

1,590 1,270
457

2,319

367
1,030 700

222

Total Portfolio Australian Portfolio European Portfolio Singapore Portfolio UK Portfolio

Investment Properties Debt

1. Excludes recognition of right-of-use assets upon the adoption of FRS 116 Leases with effect from 1 October 2019. 2. Refers to debt in the currency or hedged currency of the country of the investment properties.

Investment Properties(1) and Debt(2) as at 31 March 2021

Interest Risk Management as at 31 March 2021

Prudent capital management 

70.6%

Borrowings at fixed rates

▲ 13.2 p.p from 31 Dec 20



Portfolio Review
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Walter-Gropius Straße 19, Bergheim, Germany
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Portfolio overview
Selectively diversified portfolio with attractive metrics

1. As at 31 March 2021 and based on portfolio value which excludes the recognition of right-of-use assets upon the adoption of FRS 116 Leases with effect from 1 October 2019.   2. Based on GRI, being the contracted rental 

income and estimated recoverable outgoings for the month of March 2021. Excludes straight lining rental adjustments and include committed leases.

Germany, 
20.7%

The Netherlands, 
4.6%

Australia, 
47.4%

Singapore, 
20.1%

United Kingdom, 
7.2%

Logistics & 
Industrial, 

58.3%

CBD 
Commercial, 

20.6%

Office & 
Business Parks, 

21.1%

Breakdown by Asset Type and Geography(1) 97 Properties in Five Developed Countries(1)

Logistics & Industrial Commercial Total

90
Properties

7
Properties

97
Properties

$3,672.0 m
Portfolio value(1)

$2,625.5 m
Portfolio value(1)

$6,297.5 m
Portfolio value(1)

2,192,481 sqm

Lettable area
339,683 sqm

Lettable area

2,532,164 sqm

Lettable area

5.3 years

WALE(2)

3.9 years

WALE(2)

4.7 years

WALE(2)

5.2 years

WALB(2)

3.4 years

WALB(2)

4.4 years

WALB(2)

100.0%

Occupancy rate(2)

92.6%

Occupancy rate(2)

96.8%

Occupancy rate(2)

~S$6.3 billion

Portfolio Value(1)
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62,587 sq m of leasing for the period from January to March 2021 (“2QFY21”)

1. Calculated based on the signing gross rent (excluding any contracted fixed annual rental step-ups) of the new/renewed lease divided by the preceding terminating gross rent of each new/renewed lease (weighted by 

gross rent) of existing space.   2. Refers to reversion on leases contracted for the trailing 12-month period from 1 April 2020 to 31 March 2021.

62,587 sqm
leased/renewed in 

2QFY21, totaling 

126,133 sqm for 1HFY21

+0.1%

portfolio rental reversion 

for 2QFY21
No. of Leases

Lettable Area 

(sqm)
Average Lease Term Reversion(1)

Singapore 12 8,559 3.0 years 3.7%

Australia 1 345 5.0 years 9.9%

2QFY21 Reversion: 4.0%

TTM(2) Reversion: 1.8%

No. of Leases
Lettable Area 

(sqm)

Average Lease 

Term
Annual Increment Reversion(1)

Australia 5 53,683 2.5 years 3.0 – 3.3% -3.6%

Europe 0 - - - -

2QFY21 Reversion: -3.6%

TTM(2) Reversion: -4.1%

2QFY21 Industrial Leasing Summary

2QFY21 Commercial Leasing Summary



14

0.0% 1.8%

6.4% 7.0% 6.7%
5.2%

7.5%

5.0% 5.2%

0.9%

10.7%

3.2%

1.7%

4.7%

10.0%

4.7%

11.5%

1.2%

0.3%

1.9%

4.3%

Vacant Sep-21 Sep-22 Sep-23 Sep-24 Sep-25 Sep-26 Sep-27 Sep-28 Sep-29 Sep 2030
and beyond

Logistics & Industrial

Business Space

11.1%

Minimal near-term lease expiries

3.2% 3.5%

17.0%

11.4%

16.7%

8.7%

5.3%

7.1%

1.0%

15.0%

1.Based on GRI, being the contracted rental income and estimated recoverable outgoings for the month of March 2021. Excludes straight lining rental adjustments and include committed leases.

0.1%

 Well spread-out lease expiry profile with no more than 17.0% of GRI 

expiring in any single year

 6 industrial and 30 commercial leases expiring in FY2021, each 

constituting ≤0.4% of GRI

Portfolio Lease Expiry Profile as at 31 March 2021(1)

3.5 %

% of GRI due for 

renewal in FY2021
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Top-10 portfolio tenants
High-quality and well-diversified tenant base 

1. Based on GRI, being the contracted rental income and estimated recoverable outgoings for the month of March 2021. Excludes straight lining rental adjustments and include committed leases.  

 High-quality tenant base with majority of portfolio 

tenants comprising Government or related 

entities, MNCs, conglomerates and listed 

companies

 Well-diversified tenant base with no single 

tenant accounting for more than 5.1% of 

portfolio GRI(1)

No. Top-10 Portfolio Tenants(1) Country % of GRI

WALE 

(Years)

1. Commonwealth of Australia Australia 5.1% 4.3

2. Google Asia Pacific Singapore 3.9% 3.8

3. Rio Tinto Shared Services Australia 2.5% 9.3

4. Commonwealth Bank of Australia Australia 2.1% 1.8

5. CEVA Logistics (Australia) Australia 2.0% 4.2

6. BMW Germany 1.9% 6.7

7. Techtronic Industries Australia Australia 1.8% 2.6

8. Schenker Australia Australia 1.8% 3.6

9. Fluor United Kingdom 1.5% 4.1

10. Mainfreight The Netherlands 1.5% 4.9

24.1 %

% GRI contribution 

from Top-10 tenants

4.5 years

Average WALE for 

Top-10 tenants 

Caroline Chisholm Centre, Canberra, Australia
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23.6%

18.0%

6.2%

4.1%

6.9% 7.6%
5.5% 4.7%

3.4% 3.0% 2.8% 2.2% 2.2% 2.1% 1.7%
0.8%

5.2%

Well-diversified tenant base with low concentration risk

1. Based on GRI, being the contracted rental income and estimated recoverable outgoings for the month of March 2021. Excludes straight lining rental adjustments and include committed leases.   2. Excludes vacancies.  

Business Space

Logistics & Industrial 

Portfolio Tenant Sector Breakdown(1)(2)

 Stable and broad-based tenant mix with diversification across industries 

 Well-positioned to capitalise on sectoral trends with approximately one-third of the logistics 

and industrial portfolio(1) engaged in e-commerce and/or e-fulfilment related activities

58.8 %

% of GRI contribution 

from L&I tenants
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Update and commentary

 The REIT Manager is working closely with FLCT’s customers to overcome this challenging period together while focusing on managing any near- to mid-term 

downside risk from the pandemic

 The COVID-19 impact on FLCT’s distributable income in 1HFY21 is approximately S$1.2 million, comprising mainly rental waivers and allowance for doubtful 

receivables attributable to the Covid-19 pandemic, which has not been material for the REIT

 The REIT Manager will continue to monitor the situation closely, support our tenants and exercise prudence 

Singapore

 Minimal impact arising from

the Re-Align Framework(1)

 Expects near- to mid-term

impact on the retail

components of the Singapore

portfolio

 Closely monitoring any

impacts arising from the

additional community

measures implemented for

the period from 8 May to 30

May 2021.(2)

Europe & UK

 Limited impact on the

German and Dutch industrial

portfolio amid ongoing

lockdowns in Europe

 For the UK, the nation’s

‘Stay at Home’ national

lockdown ended on 29

March; progressive easing of

lockdown by phases since 12

April, including re-opening of

non-essential retail(3)

Australia

 Limited impact on the

industrial and commercial

properties
 Expects near- to mid-term

impact on the retail

components of the Australian

portfolio

FLCT

 No material impact to the FLCT portfolio 

to-date with only the retail segment of the 

commercial portfolio, which represents 

just 1.8%(4) of FLCT’s overall income, 

being more challenged

 Structural changes driven by the growth 

of e-commerce activities and ‘hub-and-

spoke’ trend are expected to drive 

demand for logistics and suburban office 

spaces, respectively

FLCT’s resilient portfolio, strong balance 

sheet and financial flexibility well-

positions the REIT to face the current 

challenging global environment

1. Re-Alignment Framework, Ministry of Law.   2. Updates on local situation, border measures and shift to heightened alert to minimise transmission, Ministry of Health.  3. Guidance, National lockdown: Stay at Home, 4 

January 2021.   4. Based on GRI, being the contracted rental income and estimated recoverable outgoings for the month of March 2021. Excludes straight lining rental adjustments and include committed leases. 

https://www.mlaw.gov.sg/realign/re-align-framework
https://www.moh.gov.sg/news-highlights/details/updates-on-local-situation-border-measures-and-shift-to-heightened-alert-to-minimise-transmission_4May2021
mailto:https://www.gov.uk/guidance/national-lockdown-stay-at-home


Market Information 

and Strategy

Section Divider To add a background, press Insert > Pictures > Picture from File > Send to back

Maxis Business Park, Bracknell, UK



19

$116

$94

$145

 $80

 $90

 $100

 $110

 $120

 $130

 $140

 $150

1Q17 1Q18 1Q19 1Q20 1Q21

Brisbane Melbourne Sydney

(+1.2% y-o-y)

1. Sources: Australian Bureau of Statistics and the Reserve Bank of Australia.   2. Capital Market Yields – Government Bonds – Daily (As at 29 April 2021).   3. Jones Lang LaSalle Real Estate Intelligence Service Q1 2021.

Key Economic Indicators(1) Overview of the Industrial and Commercial Market (3)
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Perth Melbourne
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1Q17 1Q18 1Q19 1Q20 1Q21

10-year average

(+0.3% y-o-y)

(+0.0% y-o-y)

(-0.6% y-o-y)

(+0.0% y-o-y)

Sequential GDP

+3.1% for the Dec 20 quarter
+3.4% for the preceding quarter 

Unemployment Rate

5.6% for the month of Mar 21
Improved from 5.8% in Feb 21

Consumer Price Index

1.1% for the 12 months to Mar 21
0.9% for the 12 months to Dec 20

Cash Rate

0.1%
Unchanged since Nov 20

10-year bond yield

1.62%
As at  29 Apr 21(2)

Key economic indicators and market overview 

https://www.quandl.com/data/RBA/F02-Capital-Market-Yields-Government-Bonds-Daily
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Key economic indicators and market overview 

Unemployment Rate

4.6% for the month of Mar 21

From 4.6% in Feb 21

Consumer Price Index 

1.7% for the 12 months to Mar 21

From 1.3% in Feb 21

• Take-up in Germany increased 19% year-on-year in Q1 2021 as the market continues to recover 

from the effects of COVID-19. Demand is largely driven by the e-commerce market which saw 

several large transactions transacted. 

• Prime rents have remained high in major logistics hubs as a result of limited supply and 

transactions signed for speculative developments of logistics parks.

• Investment volumes recorded €2 billion in Q1 2021 across the major logistics hubs, a decrease 

of 12% year-on-year.

• Prime yields however have remained at a record low of 3.35% from the last quarter after falling 

from 3.50% in Q3 2020. 

Overview of the German Industrial Market(3)

EURIBOR

-0.536% 3-month EURIBOR

Remained in the negative range(2)

Take-up and Prime Rents in Germany (for warehouses >5,000 sqm)

Key Economic Indicators in Germany(1)

Sequential GDP 

-1.7% for the Mar 21 quarter

+0.5% for the preceding quarter

Key Economic Indicators in the Netherlands(4)

Overview of the Dutch Industrial Market(3)

• Take-up levels increased 8.7% year-on-year in Q1 2021. Activity was boosted by demand from

retail and distribution sectors, which accounted for more than half of total take-up.

• Prime rents have stabilized, but strong demand and low availability are continually putting an

upward pressure on rents.

• Investment volumes have dropped in Q1 2021, partly reflecting changes in the tax regime

(RETT increased from 6% to 8%). However, demand is still strong, reflecting a shift from other

sectors to the logistics sector.

• Prime yields have compressed throughout the market to 3.4% in Q1 and are further expected

to decrease by the end of the year.

Take-up and Prime Rents in the Netherlands (for warehouses >5,000 sqm)

1. Source: Destatisches Bundesamt (Federal Statistics Office of Germany). 2. Source: https://www.euribor-rates.eu/en/current-euribor-rates/ (As at 29 April 2021). Applicable for both Germany and the Netherlands. 3. Source: BNP 

Paribas Real Estate Q1 2021.   4. Source: CBS (Statistics Netherlands).  
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Unemployment Rate

3.5% for the month of Mar 21

From 3.6% in Feb 21

Consumer Price Index 

1.9% for the 12 months to Mar 21

From 1.8% for the 12 months to Feb 21

Sequential GDP 

-0.1% for the Dec 20 quarter

From +7.8% in the preceding quarter
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https://www.euribor-rates.eu/en/current-euribor-rates/
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1. Sources: Singstat, Ministry of Trade and Industry Singapore, Ministry of Manpower Singapore.   2.Source: MAS SGS.   3. Source: CBRE, Singapore Market View, Q1 2021.   4. Alexandra Technopark is a high-specification B1 

industrial development located at the city-fringe, with certain physical attributes similar to business parks. Due to limited availability of market research information directly relating to the asset class of Alexandra Technopark, market 

research information for business parks is provided for indicative reference.

Overview of the Singapore Office and Business Park Markets(3)

Office Supply-Demand Dynamics

Net supply Net absorption Vacancy rate (RHA)
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Business Park Supply-Demand Dynamics

Grade A and Grade B Office Rents 

(S$ psf per month)
Business Park Rents(4)

(S$ psf per month) 

Net supply Net absorption Vacancy rate (RHA)
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Key Economic Indicators(1)

Sequential GDP

+2.0% for the Mar 21 quarter
+3.8% in the preceding quarter

Unemployment Rate

2.9% for the month of Mar 21
From 3.0% for the month of Feb 21

Consumer Price Index 

1.3% y-o-y in Mar 21
0.7% y-o-y in Feb 21

Singapore Overnight Rate(2)

0.1760%
As at 29 Apr 21

10-year bond yield

1.62%
As at  29 Apr 21(2)

Key economic indicators and market overview 



221. Source: Office for National Statistics.   2. Source: Bank of England, published April 2021.  3. Source: CBRE Research South East Q1 2021.

South East Office Trends and Outlook(3)

• Take-up levels across the South East totaled 647,890 sqft in Q1 2021, the highest level of take-up

since the beginning of the pandemic. This is also the strongest Q1 since 2015 and an increase of 8%

on the 10-year Q1 average. The development pipeline remains severely constrained with just 289,000

sf completing in 2020, 68% below average.

• Prime rents have remained largely stable across the South East office market.

Key Economic Indicators(1)

Sequential GDP

+1.3% for the Dec 20 quarter
+16.9% in the preceding quarter

Unemployment Rate

4.9% for the three months to Feb 21
5.0% for the three months to Jan 21

Consumer Price Index 

1.0% for the 12 months to Mar 21
0.7% for the 12 months to Feb 21

Bank Rate

0.1%
Unchanged since March 20

Key economic indicators and market overview 
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Harnessing competitive advantages to create long-term value and sustainable returns

◆ Our Objectives:

Deliver stable and regular distributions to unitholders

Achieve sustainable long-term growth in DPU 
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FLCT objectives and strategies

Active Asset

Management

 Proactive leasing to maintain 

high occupancy rate, long 

WALE and a diversified tenant 

base

 Assess and undertake AEIs(1)

to unlock further value

Selective

Development

 Development of properties 

complementary to the existing 

portfolio

 Re-development of existing 

assets and by leveraging the 

Sponsor’s development 

pipeline

Acquisition

Growth

 Pursue strategic acquisition 

opportunities of quality 

properties

– Sponsor’s ROFR, with a value 

in excess of S$5 billion 

– Third party acquisitions

Capital & Risk 

Management

 Optimise capital mix and 

prudent capital management

1. Development activities can be up to 10% of the current AUM as per MAS guidelines. FLCT may exceed the regulatory limit of not more than 10% of the company’s deposited property (subject to maximum of 25%) only 

if additional allowance of up to 15% of the deposited property is utilised solely for redevelopment of an existing property that has been held for 3 years and continues to be held for 3 years after completion and specific 

approval of unitholders for redevelopment is obtained. 
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Farnborough Business Park, the United Kingdom
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1. Excludes the properties at 5 Butler Boulevard, 18-20 Butler Boulevard, and 20-22 Butler Boulevard at Adelaide Airport, South Australia which are classified as “Investment 

Properties Held for Sale”.   2. As at 31 March 2021 and excludes the recognition of right-of-use assets upon the adoption of FRS 116 Leases with effect from 1 October 2019.   

3. Based on GRI, being the contracted rental income and estimated recoverable outgoings for the month of March 2021. Excludes straight lining rental adjustments and 

include committed leases.   4. 95.5% of the leases have either CPI-linked indexation or fixed escalations.   

As at 31 March 2021 Australia Europe Total

No. of Properties 59(1) 31 90

Portfolio Value(2) S$2,081.5 m S$1,590.5 m S$3,672.0 m

Lettable Area 1,311,199 sqm 881,282 sqm 2,192,481 sqm

Average Age by Value 8.6 years 8.8 years 8.7 years

WALE(3) 4.4 years 6.8 years 5.3 years

WALB(3) 4.4 years 6.8 years 5.2 years

Occupancy Rate(3) 100.0% 100.0% 100.0%

Average Annual Rental Increment 3.1% Fixed/CPI-linked(4) N.M.

Land Tenure

by Value(2)

Dutch Properties (5)

German Properties (26)

Australia

< 2 years, 
2.1%

2-5 years, 
27.1%

5-10 years, 
25.8%

>10 yrs, 
45.0%

Portfolio Age 

by Lettable 

Area

Freehold, 
65.1%

> 75 Year 
Leasehold , 

21.2%

Other 
Leasehold, 

13.7%

(12)

(16)

(1)

(3)

(30)

Germany & 

the Netherlands

Portfolio overview – logistics & industrial 
Prime and modern properties in Australia, Germany and the Netherlands
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Portfolio overview – commercial
Quality & well-located commercial portfolio

Cross Street 

Exchange

357 Collins

Street

Central

Park

Caroline 

Chisholm 

Centre

Alexandra

Technopark

Farnborough 

Business Park

Maxis Business 

Park

As at 31 March 2021 CBD Commercial Office and Business Parks Total

Country Singapore
Melbourne, 

Australia
Perth, Australia Canberra, Australia Singapore United Kingdom United Kingdom -

Ownership 100.0% 100.0% 50.0% 100.0% 100.0% 100.0% 100.0% -

Property Value 

(S$ m)(1)
644.2 327.5 324.0(2) 251.0 624.2 328.8 125.8 2,625.5

Lettable Area (sqm) 36,497 31,962 66,029 40,244 96,086 51,006 17,859 339,683

WALE(3) 2.5 years 2.4 years 6.0 years 4.3 years 2.8 years 5.2 years 5.9 years 3.9 years

WALB(3) 2.5 years 2.4 years 6.0 years 4.3 years 2.6 years 3.9 years 2.6 years 3.4 years

Occupancy Rate(3) 82.6% 95.6% 82.9% 100.0% 98.7% 91.8% 100.0% 92.6%

1. As at 31 March 2021 and excludes the recognition of right-of-use-assets upon the adoption o FRS116 Leases with effect from 1 October 2019. 2. Based on 50% interest in the property. 3. Based on GRI, being the 

contracted rental income and estimated recoverable outgoings for the month of March 2021. Excludes straight lining rental adjustments and include committed leases. 
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Breakdown by asset type

1.Based on GRI and includes committed leases.  

Logistics & Industrial As at 31 Mar 21 As at 31 Dec 20 Change

Australia 100.0% 100.0% -

Europe 100.0% 100.0% -

Logistics & Industrial Portfolio: 100.0% 100.0% -

Occupancy rate

Commercial Country As at 31 Mar 21 As at 31 Dec 20 Change

Cross Street Exchange Singapore 82.6% 89.0% ▼ 6.4%

Alexandra Technopark Singapore 98.7% 97.2% ▲ 1.5%

Central Park Australia 82.9% 82.9% -

Caroline Chisholm Centre Australia 100.0% 100.0% -

357 Collins Street Australia 95.6% 95.5% ▲ 0.1%

Farnborough Business Park United Kingdom 91.8% 94.0% ▼ 2.3%

Maxis Business Park United Kingdom 100.0% 100.0% -

Commercial Portfolio: 92.6% 93.6%
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Top-10 Logistics & Industrial Tenants(1)

% of FLCT 

Portfolio GRI WALE (Years)

Ceva Logistics, Australia 2.0% 4.2

BMW, Germany 1.9% 6.7

Techtronics Industries, Australia 1.8% 2.6

Schenker, Australia 1.8% 3.6

Mainfreight, the Netherlands 1.5% 4.9

Hermes, Germany 1.3% 11.7

Constellium, Germany 1.3% 6.2

Bakker Logistics, the Netherlands 1.3% 9.6

Bosch, Germany 1.2% 7.3

Martin Brower Australia Pty Ltd 1.2% 15.5

Total:

15.3%

Average:

7.0 years

1. Based on GRI, being the contracted rental income and estimated recoverable outgoings for the month of March 2021. Excludes straight lining rental adjustments and include committed leases.   

Top-10 Commercial Tenants(1)

% of FLCT 

Portfolio GRI

WALE 

(Years)

Commonwealth of Australia 5.1% 4.3

Google Asia Pacific, Singapore 3.9% 3.8

Rio Tinto, Australia 2.5% 9.3

Commonwealth Bank of Australia 2.1% 1.8

Fluor Limited, United Kingdom 1.5% 4.1

WeWork, Australia and Singapore 1.1% 9.2

GroupM Singapore Pte Ltd, Singapore 1.0% 2.3

Service Stream, Australia 1.0% 3.7

Syneos Health UK Ltd, UK 0.9% 6.8

Suntory Beverage & Food Asia Pte Ltd, 

Singapore
0.7% 2.2

Total:

19.8%

Average:

4.7 years

Top-10 tenants
Breakdown by asset type
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0.0%
1.5%

5.7% 5.6% 5.7%

3.5%

4.6%

3.3%
2.5%

0.0%

4.1%
0.3%

0.7%
1.4% 1.0%

1.7%

2.9%

1.7%
2.7%

0.9%

6.6%

Vacant Sep-21 Sep-22 Sep-23 Sep-24 Sep-25 Sep-26 Sep-27 Sep-28 Sep-29 Sep 2030
and beyond

Australia

Germany and the Netherlands

6.4%

7.5%

0.9%

7.0%

6.7%

5.2% 5.0% 5.2%

10.7%

1.Based on GRI, being the contracted rental income and estimated recoverable outgoings for the month of March 2021. Excludes straight lining rental adjustments and include committed leases.

1.8%

Lease expiry profile

Industrial Portfolio Lease Expiry Profile as at 31 March 2021(1)

(% of total FLCT Portfolio GRI)

Logistics & Industrial        
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1.3%
0.4% 0.4%

3.2%

0.6%

6.4%

0.1% 0.3%
0.2%

0.1%

3.2%
1.4%

1.2%

2.9%

4.0%

3.7%

3.9%

0.3%

0.5%

0.7%
0.5%

0.1%

1.4%

2.8%

0.4%

1.2%

0.8%
0.0% 1.2%

0.0%

0.4%

Vacant Sep-21 Sep-22 Sep-23 Sep-24 Sep-25 Sep-26 Sep-27 Sep-28 Sep-29 Sep 2030
and beyond

Australia Singapore UK

3.2%

4.7%

10.0%

4.7%

1.2%

11.5%

0.3%

1.9%

4.3%

1.7%

1.Based on GRI, being the contracted rental income and estimated recoverable outgoings for the month of March 2021. Excludes straight lining rental adjustments and include committed leases.

Commercial Portfolio Lease Expiry Profile as at 31 March 2021(1)

(% of total FLCT Portfolio GRI)

Lease expiry profile
Commercial 
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Industrial Leadership
 The industrial portfolio was named Global Sector Leader (Listed Industrial) for the third consecutive 

year in the 2020 GRESB Assessment(1)

Highest Rated 

Industrial Portfolio in 

Australia

 Highest Green Star performance-rated industrial portfolio in Australia(2)

 First to achieve 6 Star Green Star ratings for industrial facilities in each of New South Wales, Victoria 

and Queensland

Strong

Commercial 

Performance
 Top-5 in Asia Pacific Diversified – Office/Industrial(1)

1. Refers to the 2020 Real Estate Assessments by GRESB, the global ESG benchmark for real estate. 2. Portfolio Green Star ratings as at 30 September 2020. Green Star ratings are awarded by the Green Building Council of 

Australia (GBCA) which has assessed the Australian properties against nine key performance criteria – energy, water, transport, materials, indoor environment quality management, land use and ecology, emissions and innovation.  3. 

Based on lettable area.  4. Refers to the National Australian Built Environment Rating System, Australia’s leading independent, evidence based built environment rating system.  5. Refers to the Building Research Establishment 

Environment Assessment Method, the world’s leading sustainability assessment for master planning projects, infrastructure and buildings.  6. Green Mark certification by the Building and Construction Authority, Singapore.  7. Green 

Mark re-certification for Alexandra Technopark is currently underway. Alexandra Technopark was certified Green Mark Gold prior to re-certification. 

Minimum 4.5-star 

NABERS(4) Energy 

ratings

 357 Collins Street and Caroline Chisholm Centre: minimum 5.0-star 

 Central Park: first commercial building in Australia to achieve 4.5-star NABERS Energy base building 

rating, first premium office building in Perth to attain 5.0-star NABERS Energy base building rating

BREEAM ratings(5)
 Farnborough Business Park and Maxis Business Park: ‘Excellent’/ ‘Very Good’ BREEAM ratings 

BCA Green Mark 

Gold Plus
 Cross Street Exchange: BCA Green Mark Gold Plus certification

Please visit the FLCT website for more details on its sustainability strategy and performance 

BCA rating(6)(7)
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Cross Street Exchange, Singapore
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Sources: Jones Lang LaSalle Real Estate Intelligence Service – Sydney Industrial Final Data 1Q21; Jones Lang LaSalle Real Estate Intelligence Service – Sydney Industrial Snapshot 1Q21; Jones Lang LaSalle Real Estate Data 

Solution – Sydney Construction Projects from Q2 2011 to 1Q 2021; Knight Frank Research – National Industrial March 2021. 

Sydney Industrial Total Supply Sydney Industrial Prime Grade Net Face Rents 

◆ Supply: Over the last 12 months, 439,990 sqm of new stock was completed in Sydney which is below the historic ten-year average. There were limited new completions in the first quarter of

2021 (“1Q21”) with only 3 developments reaching completion totalling 31,749 sqm of GLA. The Sydney development pipeline remains strong with approximately 539,000 sqm of new stock either

under construction or with approved plans.

◆ Demand: In 1Q21, Sydney recorded 313,113 sqm of gross take-up which is significantly higher than the historic ten-year average. The strong gross take-up is supported by rising demand

from eCommerce users. This has resulted in the Retail Trade sector accounting for 41% of gross take up during the quarter. The second and third largest user groups were Postal, Transport and

Warehousing users (32%) and Wholesale Trade users (10%).

◆ Rents: Low vacancy rates and a shortage of developable land has translated to an average y-o-y rental growth of approximately 1.2% across all industrial precincts. The Outer Central

West continues to perform strongly with net face rents growing by 3.2% to A$130/sqm. Prime industrial incentives have also increased slightly over the previous 12 months although they remain

relatively low compared to other markets. Average prime incentives in the Outer Central West currently sitting at 16%.

◆ Vacancy: As at March 2021, industrial vacancies in Sydney remain near historic 5-year lows with approximately 575,149 sqm of available space. Sydney industrial vacancy are expected to

increase over the next 12 months as new speculative stock is completed.

Australian industrial market 
Sydney
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Sources: Jones Lang LaSalle Real Estate Intelligence Service – Melbourne Industrial Final Data 1Q21; Jones Lang LaSalle Real Estate Intelligence Service – Melbourne Industrial Snapshot 1Q21; Jones Lang LaSalle Real 

Estate Data Solution – Melbourne Construction Projects from Q2 2011 to 1Q 2021; ; Knight Frank Research – National Industrial March 2021. 

Melbourne  Industrial Total Supply Melbourne Industrial Prime Grade Net Face Rents 

◆ Supply: A total of four projects with a total GLA of 125,660 sqm reached practical completion in Melbourne over 1Q21. Over the last 12 months, 767,325 sqm of new stock was completed in

Melbourne which is significantly above the historic ten-year average. In 1Q21, the bulk of new industrial supply were concentrated in the Northern (53%) and Western Precincts (47%), reflective of

their less restrictive land supply environments.

◆ Demand: With lockdown restrictions easing in Victoria, leasing activity has significantly increased over the previous two quarters. Gross take-up for 1Q21 totalled 546,939 sqm which is the

highest recorded gross-take up for the Melbourne market on record. The West industrial precincts recorded over 307,000 sqm of gross take representing 56% of all take up during the quarter.

◆ Rents: Due to high levels of new supply in Melbourne, industrial face rents have generally remained flat, however there has been a slight face rental growth in the South East and North

industrial precincts. The South East continues to be one of the strongest performing precinct with face rents increasing slightly to A$95/sqm net. Incentives in South East have also remained stable

at around 23%.

◆ Vacancy: During the March quarter, vacancies in Melbourne declined 20% as a result of strong tenant demand. As at March 2021, there was approximately 886,314 sqm of available industrial

space in the Melbourne market. However, vacancy rates in Melbourne are expected to increase over the next 12 months as new speculative stock is completed.
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Sources: Jones Lang LaSalle Real Estate Intelligence Service – Brisbane Industrial Final Data 1Q21; Jones Lang LaSalle Real Estate Intelligence Service – Brisbane Industrial Snapshot 1Q21; Jones Lang LaSalle Real Estate Data 

Solution – Brisbane Construction Projects from Q2 2011 to 1Q21; Knight Frank Research – National Industrial March 2021.

Brisbane Industrial Total Supply Brisbane Industrial Prime Grade Net Face Rents 

◆ Supply: During the March quarter, two developments were completed in Brisbane adding 12,800 of GLA to the market. Over the last 12 months, development activity in Brisbane has exceeded the

10-year average, with 378,605 sqm of new stock being added to the market. The largest completion during the quarter was a 7,000 sqm warehouse at 498 Progress Road, Wacol developed by

Garda Capital Group. The supply pipeline remains relatively strong with 11 projects under construction, totalling 205,450 sqm which are expected to complete in 2021 and 2022.

◆ Demand: Tenant demand for industrial space in Brisbane has remained in line with the historic 10-year quarterly average. During the March quarter Brisbane recorded a gross take-up of

117,994 sqm. 75% the new leases were concentrated in the South with the remaining 25% in the Trade Coast. The largest transaction of the quarter was a 19,650 sqm lease to Eureka Street

Furniture at 33 Iris Place, Acacia Ridge.

◆ Rents: Rental rates remained relatively stable across Brisbane over 1Q21. The only market to record rental growth over the previous 12 months was the Southern industrial precinct. Face rents

increase 0.9% to A$111/sqm net. Incentives in Brisbane South have remained stable at 20% for prime industrial assets however incentives are expected to increase as new speculative developments

reach completion.

◆ Vacancy: Vacancy levels in Brisbane have increased in 1Q21 as a result of speculative developments reaching completion. As at March 2021, the level of available industrial space is approximately

612,732 sqm. However, vacancy rates in Brisbane are expected to increase over the next 12 months as new speculative stock is completed.
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Sources: Jones Lang LaSalle Real Estate Intelligence Service – Melbourne CBD Office Final Data 1Q21; Jones Lang LaSalle Real Estate Intelligence Service – Melbourne  CBD Office Snapshot 1Q21; Jones Lang LaSalle Real 

Estate Data Solution – Melbourne CBD Office  Construction Projects from 2Q 2011 to 1Q 2021.

Melbourne Commercial Total Supply Melbourne Prime Grade Net Face Rent

◆ Supply: There were no new major commercial developments completed in the Melbourne CBD in 1Q21. During 2020, a total of seven new projects were completed in the Melbourne CBD

contributing approximate 329,000 sqm of net lettable area (“NLA”) making 2020 the highest year for completions since 1991. There are currently five new developments and two building refurbishments

under construction in the Melbourne CBD. The developments will provide 260,270 sqm of NLA to the market and are due to be completed by 2023.

◆ Demand: Tenant demand in Melbourne CBD has continued to remain weak however enquiry has begun to pick up as COVID restrictions continue to ease in Victoria. During 1Q21, the

Melbourne CBD experienced negative net absorption of 56,195 sqm as tenants continued to offer sublease space to the market. Occupier demand is expected to remain subdued over the short term, as

tenants continue to assess future office space requirements. JLL expects the Melbourne market to recover throughout 2021 with leasing activity increasing throughout the year.

◆ Rents: Tenant demand in the Melbourne CBD has remained subdued over Q1 2021 and has resulted in an increase in vacancies and incentives. Over the last 12 months average net prime rents in

Melbourne CBD have increased by 1.2% to A$624/sqm. Although we note that face rents have not recovered to their pre-COVID levels. Prime incentives in the Melbourne CBD have also increased

slightly over the quarter and are currently at 34%. Despite the positive rental growth, the increase of incentives has resulted in negative effective rental growth over the quarter.

◆ Vacancy: As at 1Q21, the vacancy rate in Melbourne’s CBD rose to 14.3%, being the highest level since 1999. This increase is due to a combination of weak tenant demand, increased sublease space

as well as several large tenant contractions. As at 31 March 2021, there is approximately 727,725 sqm of vacant commercial space in the Melbourne CBD. According to JLL, vacancies are expected to

peak in 2021 as new supply reaches completion and additional sublease space is offered to the market.
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Sources: Jones Lang LaSalle Real Estate Intelligence Service – Perth CBD Office Final Data 1Q21; Jones Lang LaSalle Real Estate Intelligence Service – Perth CBD Office Snapshot 1Q21; 

Jones Lang LaSalle Real Estate Data Solution – Perth CBD Office Construction Projects from Q2 2011 to 1Q21. 

Perth CBD Office Total Supply Perth CBD Office Prime Grade Net Face Rent

◆ Supply: Development activity in the Perth CBD has been subdued with no new developments being completed in the last 12 months. There are currently two major new developments under

construction in the Perth CBD, Chevron HQ and Capital Square Tower 2. The two developments are expected to be completed in 4Q 2023 and 4Q 2021 respectively and will provide approximately

79,200 sqm of commercial space to the Perth Market. Due the persistently high vacancy rates in Perth there is unlikely to be any additional developments added to the supply pipeline.

◆ Demand: Tenant demand has remained subdued with Perth CBD experienced negative net absorption of 2,600 sqm. Tenant enquiry has begun to pick up particularly for fitted out B-grade office

accommodation. The new enquiry is primarily driven by the mining and professional service sectors. The WA State Government remains an active player in the market as it continues to review its

office space requirements.

◆ Rents: Despite softening demand, prime rents in the Perth CBD remained stable over the previous 12 months. The average net prime rents in the Perth CBD are currently A$625/sqm. Over the

quarter incentives for prime office space have also remained stable at 49%. The high-level of incentives is due to continued high vacancy rates and modest tenant demand in the Perth CBD office

market.

◆ Vacancy: During 1Q 2021 the vacancy rate in Perth CBD increased slightly to 20.16%. Currently, there is approximately 364,401 sqm of vacant commercial space in the Perth CBD market. Vacancy

rates are expected to decrease as demand from the mining and professional service sector are expected to increase over the next 12 months.
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Source: CBRE, Singapore Market View, Q1 2021.

Singapore Grade A and Grade B office rents

◆ Supply: There has been some new office completions in Q1 21, bringing total new completions in the 12-month period to 31 March 21 at c.636k mil sq ft. The bulk of the office supply will be 

injected into the market from 2021 to 2023, with bigger projects that include Capitaspring, Guoco Midtown and Central Boulevard Towers slated for completion by 2023. 

◆ Demand: There has been an uptick in leasing momentum, total net absorption in 1Q21 was positive at 134,348 sq ft. In particular, Grade A (Core CBD) market registered a positive net absorption, 

as occupier capitalised on declining rents and moved to prime office buildings. Demand mainly driven by firms from the technology and financial services industries. 

◆ Rents: In Q1 21, Grade A rental rates remained stable q-o-q at $10.40 psf/month. While Grade B market rents continue to grapple, seeing a further rental decline of 1.3% q-o-q to $7.80 psf/month.

◆ Vacancy: Coupled with lower occupancy of the new-builds upon completion, as well as the impact of slower demand with firms re-evaluating their real estate footprint and downsizing, vacancy rose 

from 5.0% in Q1 20 to 5.9% in Q1 21. 
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Singapore office rents
1Q 21

(psf/ month)

Q-o-q

(%)

Grade A CBD Core S$10.40 -

Grade B CBD Core S$7.80 ▼ 1.3

Grade B Islandwide S$7.20 ▼ 2.0

Singapore commercial market 
CBD office 
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◆ Supply: The completion of on-going projects are expected to be delayed by at least three months due to disruptions in the construction industry. From 2021 to 2023, an estimated 4.14 million sq ft of 

new supply will come on stream.

◆ Demand: Leasing activity was subdued in Q1 2021, with renewals and relocations continuing to feature. Total island wide net absorption registered at negative 35,817 sq ft in Q1 2021.

◆ Rents: With landlords becoming more flexible in rental negotiations as they seek to maintain occupancy levels, both City Fringe and Rest of Island markets registered a drop in rents. The former saw a 

decrease of 0.9% q-o-q to $5.75 psf/ month whereas the latter saw a less steep drop of 1.4% q-o-q to $3.65 psf/month. The upcoming supply e.g. Clean TechPark slated for completion in 2021 is 

likely to put pressure on rents. 

◆ Vacancy: Island wide vacancy rate eased slightly from 13.0% in 3Q20 to 12.8% in 4Q20 with no new supply over the past three months. Occupancy rate is unlikely to dip significantly as there is 

limited large contiguous space in city fringe business parks 

Source: CBRE, Singapore Market View, Q1 2021.

1. Alexandra Technopark is a high-specification B1 industrial development located at the city-fringe, with certain physical attributes similar to business parks. Due to limited availability of market research information directly relating 

to the asset class of Alexandra Technopark, market research information for business parks is provided for indicative reference.

Singapore Business Park rents

Singapore business park 

rents

1Q 21

(psf/ month)

Q-o-q

(%)

City fringe S$5.75 ▼ 0.9

Rest of Island S$3.65 ▼ 1.4

Singapore commercial market 
Business park(1)




